
 

 

FLOODPLAIN MODELING AND MAPPING USING GIS & HEC- RAS 

ON DOWNSTREAM REACH OF DIJO RIVER, ALAGE, ETHIOPIA 

 

 

 

 

MSC, THESIS 

 

 

 

MEKA TIRA WUDA 

 

 

 

 

 

                                                                                            FEBRUARY  2022 

  HAWASSA, ETHIOPIA 



FLOODPLAIN MODELING AND MAPPING USING GIS & HEC-RAS ON 

DOWNSTREAM REACH OF DIJO RIVER, ALAGE, ETHIOPIA 

 

MEKA TIRA WUDA 

 

 

A THESIS SUBMITTED TO SCHOOL OF WATER RESOURCE ENGINEERING, 

INSTITUTE OF TECHNOLOGY, SCHOOL OF GRADUATE STUDIES, 

HAWASSA UNIVERSITY, HAWASSA, ETHIOPIA 

 

 

 

 

 

 

IN PARTIAL FULFILLMENT OF THE REQUIREMENTS FOR THE DEGREE 

OF MASTER OF SCIENCE IN HYDRAULIC ENGINEERING 

  

 

 

 

 

 

FEBRUARY 2022



I 

 

 

ACKNOWLEDGEMENT 

First, I like to say Alhamdulillah, Almighty, and Merciful ALLAH gave to me strength 

during my research work.  

I want to say thank you, my advisor, Dr.Abebe Tadess for his great support, 

multidirectional advice, and guidance to do this thesis, and I offer thanks to Mr. Nebiyat 

fiqade (M.SC) co-advisor for their valuable comments, recommendations, and 

contributions. 

I say thank you to my beloved families especially, my wife Meliya Edris, her parents for 

their financial and holistic guidance and my sons Abdellah Meka and Hibetula Meka for 

their unspeakable love, which is very important for all of my success.  I provide thanks to 

silte zone water mine and energy department office, Silte zone administration office and 

worabe comprehensive specialized hospital they helped me from instrumental (total 

station, cars), financial support and for their permission for to use internet access. Lastly, 

I want to thank you for all of my friends, who gave me good advice to my success of the 

research.  

 

 

 

 

 

 

 

 

 

 

 

 



II 

 

 

 

CONTENTS 

ACKNOWLEDGEMENT .................................................................................................... i 

ACRONYMS ....................................................................................................................... v 

LIST OF TABLES .............................................................................................................. vi 

LIST OF FIGURES ........................................................................................................... vii 

LIST OF APPENDICES TABLE ....................................................................................... ix 

LIST OF APPENDICES FIGURES .................................................................................... x 

ABSTRACT ........................................................................................................................ xi 

1 INTRODUCTION ........................................................................................................ 1 

1.1 Background ........................................................................................................... 1 

1.2 Statement of Problem ............................................................................................. 2 

1.3 Objective ............................................................................................................... 3 

1.3.1 General Objective .......................................................................................... 3 

1.3.2 Specific objective ........................................................................................... 3 

1.4 Research Questions ............................................................................................... 3 

1.5 Scope of the Study................................................................................................. 3 

1.6 Limitation of the Study ......................................................................................... 4 

1.7 Significance of the Research ................................................................................. 4 

2 LITERATURE REVIEW ............................................................................................. 5 

2.1 Floods in Ethiopia ................................................................................................. 5 

2.2 FLOOD CHARACTERISTICS ............................................................................ 8 



III 

 

2.3 Geographic information system (GIS) .................................................................. 8 

2.4 Hydraulic modeling and floodplain mapping........................................................ 9 

2.4.1 1-Dimensional (1D) ....................................................................................... 9 

2.4.2 2-Dimensional (2D) ..................................................................................... 11 

2.5 HEC-GEORAS.................................................................................................... 11 

2.6 Flood Frequency Analysis ................................................................................... 15 

2.6.1 Gumbel Extreme Value Type-I distribution ................................................ 16 

3 MATERIALS AND METHODS ............................................................................... 17 

3.1 Study Area description ........................................................................................ 17 

3.1.1 Topography .................................................................................................. 17 

3.1.2 Soil ............................................................................................................... 17 

3.1.3 Land use ....................................................................................................... 17 

3.1.4 Rainfall distribution ..................................................................................... 17 

3.2 Dijo River ............................................................................................................ 18 

3.3 Available Data’s .................................................................................................. 19 

3.3.1 Geometric Data ............................................................................................ 20 

3.3.2 Hydrological Data ........................................................................................ 20 

3.4 Methodology ....................................................................................................... 20 

3.4.1 Missing data................................................................................................ 21 

3.4.2 Hydraulic Analysis....................................................................................... 22 

3.4.3 Pre-processing data ...................................................................................... 24 

3.4.4 Processing/Model Execution ....................................................................... 27 

3.4.5 Post processing of data................................................................................. 28 

3.4.6 Fitting a Flood Probability Distribution ....................................................... 29 

4 Results and Discussion ............................................................................................... 31 



IV 

 

4.1 Flood frequency analysis ..................................................................................... 31 

4.2 Floodplain Modeling ........................................................................................... 33 

4.3 Flood Inundation Mapping .................................................................................. 40 

5 CONCLUSION AND RECOMMENDATION ......................................................... 45 

5.1 CONCLUSION ................................................................................................... 45 

5.2 Recommendation ................................................................................................. 46 

6 REFERENCE ............................................................................................................. 47 

7 APPENDICES ............................................................................................................ 51 

 



V 

 

ACRONYMS 

AATVETC      Alage Agricultural Technical and Vocational Educational Training 

Collage 

DEM                            Digital Elevation Model 

DHI                          Danish Hydraulic Institute 

GIS                               Geographical Information System  

HEC- GEORAS       Hydrologic Engineering Center’s Geographical River Analysis 

System 

HEC-RAS                     Hydrological Engineering Center River Analysis System 

MoWIE                        Ministry of Water, Irrigation and Energy 

SRTM                          Shuttle Radar Topography Mission 

TIN                                 Triangulated Irregular Network 

USGS                              United States Geological Survey 

WS                             Water Surface 

XS                                  Cross Section 

1D                             one- dimensional 

2D                                   two-dimensional 

 

  



VI 

 

LIST OF TABLES 

 

Table 1 Population affected and displaced by the floods between April and May 2020 ..... 5 

Table 2 Hydrological stations in Dijo watershed ............................................................... 20 

Table 3 Goodness fit test.................................................................................................... 30 

Table 4 Return periods & Peak flows ................................................................................ 32 

Table 5 Area of inundated and water level ........................................................................ 43 

 

 



VII 

 

LIST OF FIGURES 

Figure 1 Study area map .................................................................................................... 18 

Figure 2 Dijo River network .............................................................................................. 19 

Figure 3 Methodology ...................................................................................................... 21 

Figure 4 procedure of TIN data ......................................................................................... 23 

Figure 5 Dijo River Alage reach TIN ................................................................................ 23 

Figure 6  Downstream reach DEM of dijo River ............................................................... 24 

Figure 7 dijo River D/s reach geometric data .................................................................... 26 

Figure 8 Tin with geometric data ....................................................................................... 27 

Figure 9 selected x- sections along the reach..................................................................... 28 

Figure 10 probability distribution curve ............................................................................ 29 

Figure 11 probability density function ............................................................................... 30 

Figure 12 Flow duration curve ........................................................................................... 31 

Figure 13 Peak discharge versus return periods ................................................................ 32 

Figure 14 Threshold Graph ................................................................................................ 33 

Figure 15 Dijo River x- section 2675.119m ...................................................................... 34 

Figure 16  Dijo river x- section 1340.858m ....................................................................... 34 

Figure 17 Dijo River x- section of 3566.674m .................................................................. 35 

Figure 18 100 years return period directional plot............................................................. 35 

Figure 19 Dijo River x- section of 1865.22m .................................................................... 36 

Figure 20 Dijo River x- section of 3511.198m .................................................................. 36 

Figure 21 flood venerable bee farm area cross section ...................................................... 37 

Figure 22 old administration area cross section ................................................................. 38 

Figure 23 Dijo River x- section 807.846m ........................................................................ 39 

Figure 24 Dijo river x- section 3511.198m ........................................................................ 39 

Figure 25 2-years return period X-Y-Z perspective Water surface profile ....................... 40 



VIII 

 

Figure 26  2 years return period flood map........................................................................ 41 

Figure 27  locally made earthen dyke ................................................................................ 44 

  

  



IX 

 

 LIST OF APPENDICES TABLE 

Appendix- I Manning’s n coefficient--------------------------------------------------------51 

Appendix-II Table flood frequency analysis------------------------------------------------53 

Appendix-III Threshold values----------------------------------------------------------------56 

Appendix-IV Total station surveying data---------------------------------------------------58 

Appendix-V Reduced mean (Yn) Table------------------------------------------------------67 

Appendix-VI Reduced standard deviation (Sn) Table--------------------------------------68 

Appendix-VII 2-Years Return Period Hec-Ras Report-------------------------------------69 

Appendix-VIII 50-Years Return Period Hec-Ras Report-----------------------------------70 

Appendix-IX 100-Years Return Period Hec-Ras Report-----------------------------------71 

Appendix-X property of cross section --------------------------------------------------------72 

Appendix-XI property of cross section--------------------------------------------------------72 

 

  

 

 

 

 

 

 

 

 

 

 

 

 



X 

 

LIST OF APPENDICES FIGURES 

Appendix- I 25 years WS direction plot------------------------------------------------73 

APPENDEX-II 50 years WS direction plot--------------------------------------------74 

APPENDEX-III 10 year’s floodplain map---------------------------------------------75 

APPENDEX-IV 25 year’s floodplain map---------------------------------------------76 

APPENDEX-V 50 years floodplain map----------------------------------------------77 



XI 

 

 

ABSTRACT 

Flood is the most dominant common, continuously frequent and destructive natural 

disaster in the world. It causes loss of life and property, displacement of people, breaking 

of socio-economic activities and loss of fertile agricultural lands. Dijo River flood affects 

Alage ATVET Collage during rain seasons. The main objective of this research is to map 

the flood inundation area on downstream reach (Alage ATVET collage) of Dijo River. 

GIS 10.3, HEC-Geo RAS, HEC- RAS 5.0.6, excel 2016 and easy fit 5.5 software’s are 

used for this research. primary data’s (total station surveying data, field observation) and 

secondary data (Dijo and furfuro stream flow data and Manning’s n value) are used to 

conduct the research. Flood frequency analysis, pre-processing, processing/model 

execution and post-processing methods are used and got 101.22m
3
/s, 164.6 m

3
/s, 175.8 

m
3
/s, 207.58 m

3
/s and 227.83m 

3
/s peak discharge for 2, 10, 25, 50 and 100- years return 

period respectively. 27 x-section cut lines are drawn on 4km river reach geometry, among 

these 55.6 % of the x-sections are severely flood venerable x- sections from all return 

period peak flood discharges and to both side of the river reach. The flood inundation area 

of 2, 10, 25, 50 and 100 years return periods were 5702, 8154.71, 8499.96, 9271.9 and 

9851.84m
2
 respectively. This area includes both Alage ATVET collage and neighboring 

kebeles of the collage. Therefore, the responsible body makes remedial measures to 

control the flood like repair and increase the height of the exiting earthen dykes at 

upstream of alage Bera Bridge, construction of new dykes and levees at the chefe 

agricultural area, grassland area and desilting siltation-filled x-section, afforestation from 

upper watershed of the river. 

Keywords: - Alage collage, GIS, Hec-RAS, HEC-GeoRAS, Dijo River  
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1 INTRODUCTION 

1.1 BACKGROUND 

Flood is an exotic increasing of a river excesses its bank, inundating the nearby areas and 

it is also one of the grievous natural hazards in the world (El-Naqa & Jaber, 2018; 

Sunilkumar P & Vargheese, 2017). Floods are a constant threat to life and property(Dutta 

et al., 2006).  When the volume of the coming river water is greater than the carrying 

capacity of  the river the water which is excess from the river is called flood (Franco & 

Tesfaye, 2020; Marfai, 2003). It is the most dominant common, continuously frequent 

and destructive natural disaster in the world (Chakraborty & Biswas, 2020; Erena et al., 

2018) (Gebre SL, 2015). It cause loss of life and property, displacement of people, 

breaking of socio-economic activities and loss of fertile agricultural lands (Sunilkumar P 

& Vargheese K. O, 2017).  

In the world 20000 lives and 75 million peoples are affected in each year because of the 

existence of vast amount of floodplains and suitability of the floodplain areas for 

settlement (Muianga, 2004). Asian and Africa highly flood  affected continents (Erena et 

al., 2018). The impacts are more of economic impacts rather than death impacts because 

of it damages infrastructures like roads, bridges, industries, hospitals, schools and 

agricultural lands, killing of animals and damaging of large amount of food crops(Cronin 

et al., 2008). The major causes of floods are either natural or manmade. Natural causes 

may be meteorology, topographical, soil type, overtopping of banks, excessive rainfall in 

short duration earth quick, tsunamis. Manmade causes include failure of dams or levees, 

land use, rapid urbanization assisted by deforestation, encroachment of floodplain and 

several human activities (Abera, 2011; Chakraborty & Biswas, 2020; Erena et al., 2018).  

Ethiopia is one of the natural disaster (flood) affected countries in Africa country (Feyissa 

& Tufa, 2019).To manage floods,  it is important to understand hydrological response of 

the catchment using different hydraulic and hydrologic models that can support to 

quantify the magnitude of flood , to project and identify the most affected area. HEC-

RAS /HEC- GEORAS GIS extension tool is one of the common hydraulic model to solve 

flood problems (Erena et al., 2018; Feyissa & Tufa, 2019). Floodplain is the normally dry 

land area next to flooding rivers and side of rivers, which is  able to inundation during 

flood events (Chow,1988). To decrease the catastrophic impact of flooding due to rivers 
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and streams detection of the appropriate cross section, extent of flood inundation area and 

provide mitigation measure based on the output of the model is essential. To identify the 

cross section and the extent of flood covering areas need flood modeling and mapping 

tools. This tool is able to indicate appropriate flooding location and mapping the area of 

flood extent easily understandable or graphical format. This inundation map  significant 

for executive body and disaster relief officials, to better prepare emergency action plan 

for potential flood conditions (Sunilkumar & Vargheese . O, 2017). But the impact of 

flooding still continue  in developing countries because implementation of the floodplain 

management not updated by modern technology (Feyissa & Tufa, 2019). 

Downstream reach of Dijo River is a flood affected /floodplain area during rainy seasons 

(June - September). Excess  rainfall is the main cause of flooding (Bekele & Gemi, 

2021a) in Dijo River. In the flood prone areas, protection works such like earthen dyke 

constructed at the local level without preplanning and forecasting the problems. However, 

such works were not solved the problems for long time. As increasing human activity on 

watershed of the river increasing flooding and frequency at downstream of rivers (Dutta 

et al., 2006).mean monthly stream flow of dijo river  increased in wet seasons decreased 

in dry seasons (Nigusie & Dananto, 2020). This increases the probability of happing of 

flood in Dijo River. Hence, specific floodplain area identification and propose mitigation 

measure is very significant for Dijo river. The main objective of this research is to map 

the flood inundation area on downstream reach (Alage ATVET collage) of Dijo river. The 

purpose of the study is to save lives and properties settling in the collage and/or around 

the bank of the river.    

1.2 STATEMENT OF PROBLEM 

Problems associated with flood are diverse. Flooding is a recurrent event at a downstream 

reach of Dijo River around Alage ATVET collage. During rainy season, Alage ATVET 

Collage is flooded by the excess flows from Dijo River. This collage is very important 

collage of our country. However, during rain seasons it is at risk of flooding from Dijo 

River(Nigusie & Dananto, 2020). Some part of the collage like bee farm area, old 

administration office, farmlands around entrance, Ogden village animal grazing land, and 

access roads area inundated by flood in previous years. Old administration office changed 

the location to Zeray 01 village area b/c of continuous inundation of the area by flood. In 

this area many researches are did research on watershed of the river on different titles like 
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(Bekele & Gemi, 2021; Nigusie and Dananto, 2020) their research depend on land use 

land cover on hydrological process and the risk of soil erosion. But the researchers not 

include flood inundation area of the alage collage and also there are many researchers 

conduct the research in the world from their environment from this type of titles but they 

are no use real topographic data of the area.  Hence, for this research real topographic 

total station surveying data was used.  Prevention of flood and prediction of flood pattern 

in the Dijo River near the collage reach is very important for protecting the collage 

community and the surrounding areas. This will simplify sustainable the responsibilities 

in the collage and increasing productivity of the collage. Hence, Flood management for 

collage is very important task. To manage flood inundation, identify flood inundation area 

and river x- sections are important inputs.  

1.3 OBJECTIVE 

1.3.1 General Objective 

The main objective of this research is to prepare flood inundation map of an area at 

downstream reaches of Dijo River Using hec-ras hydraulic model. 

1.3.2 Specific objective 

Flood frequency analysis  

Identification of extremely vulnerable river cross sections  

flood plain map Preparation   

1.4 RESEARCH QUESTIONS 

How much volume of discharges will exist at different return periods? 

Which cross sections are extremely vulnerable for flooding? 

Which areas are likely inundated by different return period? 

1.5 SCOPE OF THE STUDY 

Although Alage ATVET collage has been affected by massive seasonal flooding, the 

range of this study restricted to geographical scope. Based on these facts, geographically 

the study is limited to downstream reach of Dijo River (alage atvt collage) due to time 

and resource limitations and the work has been concentrated on extracting geometric data, 
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calculate peak discharge, simulating, measuring water surface profiles, analyzing the 

flood inundation area with the help of hydraulic model (HEC-RAS) integrated with in 

GIS environment. 

1.6 Limitation of the Study 

This study conducts on downstream reach (Alage ATVET collage) of Dijo River through 

HEC-RAS 1D model integration with GIS and HEC GEORAS. The main objective of 

study is mapping of flood inundation area at downstream reaches of Dijo River. The 

study conducted on only 4km of Dijo River at downstream reach and by using steady 

state analysis. Calibration and validation assure the accuracy of measured data’s. But for 

this research use observed stream flow without hydrological calibration and validation. 

High resolution Landsat image also not had for this area, hence manning’s values from 

hec-ras manuals. 

1.7 Significance of the Research 

Practical floodplain maps are the most important tools to prevent the impact of floods at 

flood plain areas. These floodplain maps also improve public safety. Flood plain maps are 

an important tool for planning and emergency action plans (El-Naqa & Jaber, 2018). 

Early selection of flood-prone areas allows public safety organizations, concerned and 

responsible body has to plan the solution for early warning in the floodplain. It also 

assists the prioritization of either the maintenance of existing flood defenses or the 

construction of new ones.  
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2 LITERATURE REVIEW 

2.1 FLOODS IN ETHIOPIA 

In our country, the problem of flood continues to be of significant concern to people be 

located in lowlands, near lakes and river areas. Flood catastrophes are happening further 

frequently, and having an affected impact on Ethiopia in terms of both the human and 

economic costs. As a result of the extended and widespread heavy rainfall as of the 

beginning of 2006 main rainy season, many areas have already experienced devastating 

damage.  

According to UNISDR (2014), United Nations International Strategy for Disaster 

Reduction report, next to drought flood is hazardous disaster in Ethiopia. 

According to (Legese & Gumi, 2020) in  2006, quite 357,000  people  were affected  by 

flood  (out  of  this 600  died,  200,000  became  displaced from there home ) from this 

our  country   lost  40   million   Ethiopian   Birr. 

According to (DPPA 2006) altogether 639 people have various other parts of the country.  

therefore, need for supporting environmental planning choices with simulation, prediction 

models and early warning of flood exposed or flood plain of the river is very important 

task. 

According to, National Disaster Risk Management Commission (NDRMC, 2020) 

different region of our country affected by flood of different rivers of our country. From 

this 470163 people were affected by flooding, out these 301284 people displaced in 

Somali, Oromia, Afar and SNNP regions and Dire Dawa city council. 

Table 1 Population affected and displaced by the floods between April and May 2020 

Region Zone Woreda 

Already affected and 

displaced population as 

of mid-May 2020 

Affected IDPs 

Afar Zone 1 
Dubti 9,000 1,800 

Kori 865 173 

    Elidar 375 75 

  Zone 2 Bidu 2850 570 

  Zone 3 Amibara 5515 1103 

Sub total     18605 3721 

Oromia West Guji Gelana 63601 63601 
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    Bulle Hora 20687 20687 

Sub total     84288 84288 

SNNPR Gamo Chencha 90 90 

    Gerese 537 537 

    Gacho baba 781 781 

    Kemba 600 600 

  

South 

Omo Jinka 465 118 

    Dasenech 10185 10185 

    Debub ari 3475 336 

    Bako Dawla 2295 0 

    Male 4375 0 

    Semen Ari 95 0 

  Gofa Geze Gofa 197 197 

    Oyda 38 38 

  Alaba Wera dejo 231 175 

  Silte Sankura 305 305 

    Silte 90 90 

Sub total     23759 13452 

Dire Dewa Dire Dewa Dire Dewa 1985 1985 

Sub Total     1985 1985 

Somali Shabelle Denan 22380 138 

    Gode 10200 5280 

    Kelefo 87402 37920 

    Imay Bari 28800 13800 

    Mustahiil 33276 22824 

    Aleele 11100 3642 

    

Ber'ano and 

Abkoro 17364 2436 

    Adadle 8400 2046 

    Ferfer 28542 16920 

  Qoraxey Shilaabo 720 0 

    Debeweyeni 324 324 

  Afder Dolo Baye 6918 6918 

    Wes Ime 3072 3072 

    Kohel 390 390 

  Liben Dolo Dalo 59490 59490 

    Guradmole 204 204 

  Dawa Mubarek 1500 1500 

    Hudete 2400 2400 

  Fafan Babali 13704 13704 

    Gursum 198 198 

    Kebri Beyah 1380 1380 
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  Erer Mayu muluko 864 864 

  Nogob Ayun 330 330 

  Sitti Gotabiki 648 648 

    Gablalalu 1920 1410 

Sub total     341526 197838 

Total     470163 301284 

These indicated that different region of the country had affected by river flood in different 

time in different extent. The effect of this flooding also so huge. 

The overall conceptual approach of flood management in Ethiopia may be outlined 

around two concepts minimizing the damage of flood water through maximizing the 

benefits of flood for food security and poverty reduction. And using efficient, cost 

effective and sustainable flood management System that is institutionally manageable and 

technologically advanced and flexible. The first framework will form part of a continuous 

study, research and development to convert the ill effects of floods through deriving the 

benefit from flood water. In most cases, this involves building structural measures such as 

reservoirs, diversion structures and directing the flood water to dry areas for the purpose 

of beneficial use. The second concept focuses on institutionalized flood detection, 

prediction and issuing early warning to potential flooding area.  

These measures can be classified broadly into structural and non-structural measures.  

Many considerations have to be sought to select suitable flood mitigation measures. Some 

of the factors such as the type and characteristics of the flood (magnitude, return period, 

peak, damage, etc.), cost implications and opportunity to maximize the benefit from the 

flood water must be considered in selecting feasible solution. The structural measures 

(Engineering or Technical solution) are designed and constructed to modify the 

characteristics of floods before received to the flood damage area through various 

physical constructions such as reservoirs, diversions, levees, dykes, or channel 

modifications and river retaining works. Structural measures may be suitable to prevent 

the damages of flash floods but the enormity of the financial, economic and ethical 

requirement undermines the importance of the flood prevention measures 

Whereas non-structural measures are designed to modify the damage potential of the 

flood without interfering to the characteristics of the flood (magnitude, peak, duration, 

etc.). Such methods focus on software and hardware technological aspects, such as flood 

proofing, flood warning system, land use control, etc. For instance, through flood 

inundation mapping and early flood warning mechanism, the potential of flood damage to 
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properties and human lives can be reduced. Early warning system can be implemented to 

evacuation the population and property at risk before the flood wave reaches to the flood 

prone area. However, flood warning systems requires efficient communication network to 

relay information and message from observation stations to Forecasting center and from 

forecasting to response agencies (like DPPA) and to potential flood affected area. 

2.2 FLOOD CHARACTERISTICS 

Flood disasters are occurring more frequently, and having an ever more dramatic impact 

on Ethiopia in terms of the costs on lives, livelihoods and environmental resources. Due 

to global climate change and local environmental pressures, the occurrence and frequency 

of flood hazards and the magnitude of destruction from floods are increasing through 

time. Human activities like urbanization, mass migration, development along the flood 

plains, industrialization and fragmentation/consolidation of agriculture land are the major 

driving force in altering the land use pattern and significantly affect the hydrologic 

processes. The effect of this land transformation is to increase the flood flows. Hence, 

land use change is a major force altering the hydrological processes over a range of 

temporal and spatial scales. Land use change can affect the runoff generation and 

concentration by altering hydrological factors such as interception, infiltration and 

evaporation. Thus, it causes changes in the frequency and intensity of flooding and 

produces runoff for shorter return periods and increase the susceptibility to damage. In 

order to understand the urban impacts on flooding, the total runoff must be quantified. 

This runoff is used to compute flow profiles and flood depths.  Flood damages occur as a 

result of the particular flood event.  The factors that influence the damage are land use 

pattern, frequency of flooding, characteristics of flood including depth and duration. 

Flood studies are important because of its effect on health, living conditions and economy 

of the society and it should consider the anthropogenic factor, which increases the 

vulnerability to floods. 

2.3 GEOGRAPHIC INFORMATION SYSTEM (GIS)  

  Geographical Information System (GIS) defined as data processing technology 

(Parker,1988).it is  efficient tool in flood risk ,flood hazard, vulnerability and in risk 

assessment and useful for delineation of flood zones, preparation of flood hazard and risk 

maps assessment (Gomaa M et. al., 2012; Ali et al. 2016). GIS deals with ideas 
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developed in many areas including the fields of photogrammetry, surveying, Engineering 

and, geography and other type of fields. It is an information technology, which stores, 

analyses, and displays both spatial and non-spatial data.  Spatial data are data’s which   

represent objects that have   physical dimensions it occurs on, in, or above the planet 

Earth (Parker 1988; DJ MAGUIRE).  

According to (Tola Aliy Adem, 2018),  the ultimate purpose of GIS is carried out spatial 

analysis and creating different kinds of maps outputs using all available data.  GIS have 

extensive possibility for improving disaster management as they offer more efficiency 

and speed in the input, management, manipulation, analysis and output of 

data/information. The key benefit of using GIS for flood analyses is that it not only 

generates a visualization of flooding, but also creates potential to further analyze these 

events to estimate probable damage due to floods. Mostly, studies have applied hydraulic 

model for simulating flood runoff and runoff in low-lying flood-prone areas, in order to 

provide flood occurrence, magnitude of the event, location and depth of the inundation 

for flood management (Booij, 2005). Today state-of-the-art flood forecasting and early 

warning systems have made a significant impact to reduce the losses. By using these 

advance technologies, we can better design for flood mitigation measures, forecast 

earlier and issue possible warnings to the peoples living in low lying areas which will be 

affected.  

2.4 HYDRAULIC MODELING AND FLOODPLAIN MAPPING 

Once a design discharge (peak discharge) value has been estimated, it is converted into an 

estimate of flood water elevation, known as flood stage. There are many hydraulic models 

that vary significantly in complexity and data requirements (Daniel B. Wright, Ph.D., 

2016). The most appropriate models can be select based on the location, and the available 

data. The two most common classes of hydraulic models are: 

2.4.1 1-Dimensional (1D)  

1D model are simplified models that characterize the terrain using a series of cross 

sections. At each cross section, the flow depth and velocity perpendicular to the cross 

section is computed. These models are well suited for areas where the flow direction is 

well defined. The best- known 1D model is HEC-RAS from the U.S. Army Corps of 

Engineers.  
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2.4.1.1 HEC-RAS  

HEC-RAS (Hydrologic engineering center- river analysis system) is the basic Hydraulic 

software’s. It  is used to simulate the water flow in natural and manmade channels, 

estimate the water surface profiles of flash flood events  integration with  numerical 

models (Bezabeh, 2018; Brunner, 2016; Feyissa & Tufa, 2019). It is the best-known 1D 

model. Steady surface profile computations, unsteady flow simulation, movable boundary 

sediment transport computations and, Water quality analysis are basic component of 

HEC-RAS. This components use a common geometric data and hydraulic computation 

routines(Astride M. Adjinacou, 2016). It is the most practical, hydraulic model in the 

flood studies (Alaghmand et al., 2012). It was allowing (1D), (2D) or combined 1D and 

2D river hydraulics calculations. River geometric , stream flow and Manning data’s are 

input of HEC-RAS software  (Brunner, 2016). Additionally, it is used to  Checking the 

cross-section, editing and making correction of the river geometry and the generate water 

surface level for different return periods(Astride M. Adjinacou, 2016; Bezabeh, 2018; 

Feyissa & Tufa, 2019; Gebre SL, 2015). floodplain modeling on HEC-RAS hydraulic 

modeling provide more efficient, effective and standardized results and also saves time 

and resources(Abera, 2011; Alaghmand et al., 2012; Bezabeh, 2018; Gebre SL, 2015). 

Hydraulic models can be run in two different ways, depending on the application and the 

nature of the input design discharge. If the design discharge is a peak discharge estimate, 

then the models must be run in a steady flow mode(Daniel B. Wright, 2016).  

2.4.1.1.1 1D Steady Flow 

When the flow rate at any cross section constant with respect to time, the flow in a River 

or, stream is called steady(Gary, 2016). It improves water surface profiles by using the 

flowing formula. 

Z1+Y1+ 
�����

��     = Z2 +Y2 +
�����

��  +he 

Where 

Y1, Y2 =   Depth of water at cross sections                                                                                                                      

Z1, Z2   = elevation of the main channel inverts                                                             

a1, a2 = velocity weighting coefficients  

v1, v2 = average velocity 
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he     = energy head loss         

2.4.1.2 MIKE 11 MODEL 

It is one of the distributed model (Astride M. Adjinacou, 2016). Danish Hydraulic 

Institute (DHI) develops it in 1987. it  was a popular 1D dynamic modeling tool for  

simple and complex river and channel systems (Alaghmand et al., 2012), the 

Hydrodynamic (HD) module is the core of the MIKE 11 modeling system and forms the 

basis for most modules including Flood Forecasting, Advection-Dispersion, Water 

Quality and Non-cohesive sediment transport modules. Input files are a river network file, 

a cross-section file, a boundary file, a hydrodynamic parameter file, and a simulation file. 

But its Limitation is widely require large amount of data and the cost of data collection 

may be high; the relative complexity of the physics-based solution requires significant 

execution time (Astride M. Adjinacou, 2016). 

2.4.2 2-Dimensional (2D) 

 2D models calculate the flow both parallel and non-parallel to the main flow. They are 

useful for modeling areas of complex topography such as wider floodplains or broad 

estuaries but require high quality data and can require long computation times. Because of 

their greater complexity, most 2D models are not freely available. 

Floodplain model is one of the means to understand the behavior of flood in a particular 

area. Model simulation can provide flood depth and extent. Floodplain models are the 

representation of hydraulic and hydrologic processes in the river channel and flood plain. 

Accurate representation of the actual processes is of paramount significance in predicting 

flood extent and depth, especially explaining the transient characteristics of river water   

flow   in   the   model domain (BEZABEH, 2018). 

2.5 HEC-GEORAS 

HEC-GEORAS is one of the  Arc GIS extension  tools , which used to prepare   

geometric data (Ackerman, 2009). It is a free software but not standalone. Its main 

purpose is preparation of model and map for flooding areas. It have procedures, tools, and 

utilities for the preparation of river geometry data, which is impute  of  HEC- RAS 

(Bezabeh, 2018). Hydraulic  modeling encompasses three steps: 1) geometric data 

preparation, 2) model execution, and 3) post-processing/visualization of results, hence 

HEC-GeoRAS  perform pre- processing and post-processing data (Bezabeh, 2018; 
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Feyissa & Tufa, 2019a; Gebre SL, 2015; Sudhakar Sharma, 2015). It maps floodplain 

quickly accurately (Feyissa & Tufa, 2019).Recently, several worldwide and Ethiopian 

scholars are used HEC GEORAS to preparation of floodplain  modeling  and mapping of 

a River . The components of the river geometry are 

 River centerline  

 Bank lines  

 Flow path lines 

 Cross section lines 

Gebre, (2015) Conduct research on Awash River. His objective was analyzing flood 

hazard and inundation area mapping of Awash River Basin. He also uses HEC-RAS 

Hydraulic modeling for checking, editing imported geometric data and create water 

surface profile. He also uses the HEC-GEORAS GIS extension tool for the preparation of 

geometric files, which contains stream centerline, left and right banks, Cross sections and 

finally export the result as can read from HEC-RAS. He uses this extension tool for 

preparation of flood inundation area mapping with different flood factors. Finally, he 

maps different flood areas along Awash River basin.  Finally concludes HEC-RAS model 

is power full tool and able to give satisfied result. 

Feyissa & Tufa, (2019) conduct the research on Jima town Awitu River. He uses HEC-

RAS and HEC-GEORAS GIS extension tool hydraulic modeling. He was also using log 

normal distribution for frequency analysis method. Finally identify the flood vulnerable 

cross sections and map floodplain areas, and he conclude the HEC-RAS and HEC-

GEORAS GIS was powerful tool for floodplain modeling. 

Andreou et al. (2019) conducted a study on the 'Floodplain Mapping using Hydraulic 

Simulation HEC-RAS in G.I.S the objective of his study was floodplain mapping along 

M.Rema stream at Attica, Greecs. As a result, the study delineated floodplain areas along 

the main stream M.Rema, by using ArcGIS Hec-GeoRas and HEC-RAS. The Water 

surface profile were also prepared using the HEC-RAS by using three different flow 

data’s, 200 cross-sections cut lines from HEC-GEO RAS and use Manning’s n values 

from HEC-RAS manuals.  Finally, the Analysis detects the percentage of extent of flood 

vulnerable areas across the whole cross-sections cut lines by using three different return 

period discharges values. 
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Bezabeh, (2018) conduct research on title of floodplain mapping and modeling for Geray 

River in Jabi Tehnan Woreda, which is one of the Amhara Region woredas. The objective 

of his research was analyzing the inundation area along the Geray River by using GIS and 

HEC-GeoRAS/ HEC-RAS Model. He was use DEM, TIN, google earth surveying data 

for extraction of river cross section data. He also uses different materials for his study like 

HEC-RAS, HEC-GEORAS, and HEC-HMS AND GIS. He uses (extreme value 1) 

Gumbel’s method for flood frequency analysis. He prepares flood inundation areas along 

the Geray River by using 2 and 100 return period peak discharge values and geometric 

data. Finally, he recommends levees engineering structure for this flood mitigation 

measures. 

Azouagh et al. (2018) has done study to establishment of floodplain maps for Martil 

River in Morocco. In this research, HEC RAS hydraulic modeling used to investigate 

flood inundation areas. This research input data is DEM, aerial photograph data and 

hydro-meteorological data. Aerial photograph data are used for to create the river 

floodplain map and geometry. This research alters different flood zones, velocities and 

heights of different cross section of Martil River at Tetuan city, Morocco. Finally 

concludes HEC RAS is advanced in natural hazard management and mapping by 

delineating floodplain areas. 

El-Naqa & Jaber (2018) has done research to develop floodplain map for a concession 

area of Attarat Um Al-Ghudran Oil Shale area, Central Jordan. The researcher uses three 

major methodology stages pre-processing, processing and post processing. The study 

produces floodplain maps for the major river in the study area at three flow rates and 

finally concludes HEC-RAS is a powerful, yet easy-to-use software package for 

determining water surface profiles in a wide variety of streams. 

Sunilkumar P & Vargheese K. O, (2017) has done study to estimate the probable 

maximum flood of the Mangalam River Basin and to create the flood inundation map of 

Mangalam River Basin in a GIS platform by using 30X30 DEM, flow data and manning 

coefficient n values from HEC RAS reference manual as input data. The researcher-

modelled flood inundated area by using HEC-RAS and prepared flood inundation map by 

using GIS. At the end, the study finalizes flood inundation maps are used for preparation 

of flood mitigation plans for study area responsible executive body and HEC RAS is an 

effective tool for Flood plain modelling. 
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Hajibayov et al. (2017) conduct research on the title of Floodplain Modeling and 

Mapping Using the Geographical Information Systems (GIS) and HEC-RAS/HEC-

GeoRAS Applications. Case of Edirne, Turkey. In this study, used methodologies were 

pre-processing, processing and post processing. The study prepared 1D and 2D hydraulic 

models and compered the result. The researcher compered the result of 1D and 2D 

models and finally concluded both methods can provide reliable results on Flow 

Inundation Maps of Floods for Different Return Periods. 

Kardavani & Qalehe,(2013) conduct a study to analysis the results of the HEC RAS 

model and flood zoning in GIS environment with of Different years return periods. In 

this, research HEC 

RAS, HEC -GEO RAS, AND GIS are used for preparation of flood zoning area and to 

develop HEC RAS model parameters. The researcher prepared flood inundation area of 

study area. The results of the study indicated that, integration of GIS and hydraulic 

models can be used for flood inundation area of rivers and determining the mitigated 

areas.  

Khattak et al. (2016) carried out study to develop floodplain maps for the part of Kabul 

River in Pakistan. For this study used 90mx90m DEM data, stream flow for input, and log 

Preason type 3-flood frequency analysis method was used to calculate extreme flows with 

different return periods. Finally, floodplain maps, flooding vulnerable areas, and land use 

of type of those areas have been identified. 

Patel et al. (2018) studied the HEC-RAS one-dimensional hydrodynamic model to 

analyze prediction of water level and inundation extent along Ambica River in two 

previously flood vulnerable and Ambica River bordering villages by using the HEC-RAS 

model and past flood events. Finally, the study provides water levels and inundation areas 

along the river for different discharges and seat recommendation to construct a new 

retaining wall or rehabilitate the height of the existing wall at identified flood vulnerable 

areas. 

Jan et al. (2018), carried out study on modeling flood inundation of river kabul using hec-

georas in Pakistan. At the end of the research concludes HEC-GeoRAS model can be 

used to predict water levels at the different reach of rivers on the basis of discharge at 

recorded its upstream gaging stations, which is the best model used for flood inundation 

modeling.  
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2.6 FLOOD FREQUENCY ANALYSIS 

Flood frequency analysis is a method used to predict peak discharges with its specific 

return periods (Bezabeh, 2018). The frequency  analysis is  one of  probability  

distributions  used to relate the magnitude of extreme events to their recurrent period 

(Chow, 1988). It is one of the methods of studying the number of occurrences and 

identification of largest flood. It is also a way of preparing the flood events of a certain 

river or rivers of a specific area. The result of flood frequency analysis is the basic input 

for floodplain modeling and mapping, design of flood control structures. The 

development of all design flood estimation procedures starts with the direct statistical 

analysis of gauged station data’s(Alemu, 2007; Alexander, 2002; Bhattacharya, 2010; 

Roy & De, 2015). Statistical  analyses is used to determine the flood discharge and  its 

frequency (Alexander, 2002). According to Al-Mashidani et al.(1978) and Griffis & 

Stedinger( 2009) studies the  Pearson type III, the Gumbel extreme value distribution, and 

lognormal distribution more popularly applicable than  any other distributions.  

The relationship between the probability of a flood and its intensity gives rise to the 

concept of return period (also known as recurrence interval), represented by the symbol T 

and expressed in terms of years. A T-year flood is the flood intensity that has a 

probability of 1/T of being exceeded in a given year. This probability is called the 

exceedance probability. It is important to point out that this definition of return period is 

contrary to what the term “10-year flood” or “100-year flood” would seem to imply, (i.e., 

the intensity of a flood that would occur once every ten or one hundred years). This is a 

major source of confusion and misunderstanding around the definition of return periods 

and can result in improper estimation.  

Usually, the highest recorded discharge record from each year is used in the analysis. For 

example, if there are 30 years of daily discharge measurements available at a particular 

measuring station, then 30 data points are used in the discharge-frequency analysis, each 

one corresponding to the largest daily discharge observation from one of the 30 years of 

record. These data points are referred to as annual discharge maxima. Once these data 

points have been identified, the analyst fits several statistical distributions (for example: 

log-normal, log-Pearson, or generalized extreme value) and selects the distribution that 

most accurately describes the data. It must be emphasized that the proper application and 
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interpretation of statistical procedures requires substantial experience and specialized 

knowledge (Daniel B. Wright, Ph.D., 2016). 

2.6.1 Gumbel Extreme Value Type-I distribution 

Gumbel distribution is most applicable and suitable for the Rivers (Bhattacharya, 2010). 

The Gumbel frequency curve for extreme value distribution was an important application 

to check the relationship between magnitude maximum discharge and their probabilistic 

distribution. 

Chakraborty & Biswas, (2020) carried out research to analyze the flood risk based on 

flood hazard and vulnerability using the HEC-RAS model. He use Gumbel Extreme 

Value Type-I distribution to estimate the peak discharge of River for different return 

periods.  

Chow, (1988) stated that Storm rainfalls are most commonly modeled   by the Extreme 

Value Type I   distribution and drought by the Weibull distribution (EVIII distribution).  

XT=�	+kn-1 �	 =
∑ ��
���

�  

Y=-ln (-ln (q))  n-1=�∑ ����	�^�
���
���  

q=1-p T=
�
� =  �

��� 

K= - ������
�� � 

YT= −!" #!" � $
$���% 

Where �	= mean of the variate 

K=frequency factor   

q = the probability of non-exceedance   

 N-1= standard deviation of the variant 

 T= Return Period 

 P= Probability of occurrence   

Yn = Reduced mean 

Sn = Reduced standard deviation 



17 

 

3 MATERIALS AND METHODS 

3.1 STUDY AREA DESCRIPTION  

This study is conduct on Dijo River along Alage ATVET Collage, which is one of the 

oldest and important collages of Ethiopia, which has been, Established in the 1980. The 

collage contains Plant science, Animal science, natural resource and animal health 

department; the departments are located on average 3-5km with each other. The collage 

provides courses and training on animal health, dairy, poultry, bee farm, fruits, 

vegetables, and water harvesting and alternatives energy sources.  It is located 41 km 

from worabe town and 215 km South of Addis Ababa around Abiata and shalla rift valley 

lakes. Geographically the collage is lies between in latitude 7°34’30 and 7°37’30 and 

longitude 38°23'30'E and 38°30'30'E. It covers total area of 2948 Hectare (29.48km
2
).  

3.1.1 Topography 

The elevation of the catchment ranges from 1573.80 m to 3194m amsl at northern ridge 

of Alicho wuriro. The upper part of the catchment is highly mountainous, undulating, 

rugged and hilly topography but the downstream area is very flat. 

3.1.2 Soil 

soil types of the watershed are Chromic Luvisols, Chromic Vertisols, Chromic Vertisols, 

Eutric Cambisols, Luvic Phaeozems, Pellic Vertisols and Vitric Andosols.  

3.1.3 Land use  

The watershed contains many types of land uses. According  to (Bekele & Gemi, 2021; 

Nigusie & Dananto, 2020)  the watershed mainly dominated by diverse land use land 

cover; includes forest, agriculture and settlement, shrub and grassland, barren land, 

settlement  and  water  bodies,  which  comprises  about  5.9,  60.1, 31.9, 1.8 and 0.3%, 

respectively, based on 2018 LULC.  

3.1.4 Rainfall distribution  

Five stations (Halaba, Wulbareg  butajira and ziway) are inside the watershed. As a result 

annual average rainfall of the study area 975.5 mm/yr. The rainfall is bi-modal type I,e 

heavy rainfall from June to September and low rainfall from March to May. Mean 

maximum temperature of the watershed is 26.9°C and the mean minimum temperature is 

13.2°C. The mean annual potential evapotranspiration (PET) 153.5 mm/yr. 



18 

 

 

Figure 1 Study area map 

3.2 DIJO RIVER 

Dijo River is one of the seasonal rivers in southern part of Ethiopia. The length of the 

river is around 75.19km in length. The starts from Alicho wuriro Woreda Mountains 
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areas and it cross five woredas (Alicho wuriro, worabe town administration, Dalocha, 

Sankura, Mitto) of silte zone, one Halaba zone woreda Finally joining Shalla Lake along 

Alage ATVET collage. Kalid, Limaza and furfuro rivers are tributary of the River. The 

largest part of the river is located in the silte zone in the Southern part of Ethiopia. 

 

Figure 2 Dijo River network 

3.3 AVAILABLE DATA’S 

The result of expected objective of the study and the efficiency of models are depending 

on the reliability, Accuracy and availability of the geometric and hydrological 

data(BEZABEH, 2018; Hajibayov et al., 2017). I use primary data’s and secondary data’s 

for this research. The primary data’s are total station surveying/field observation/site visit 

data from the Dijo River in Alage ATVET collage. The secondary data’s are Dijo and 
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furfuro stream flow data and collect from the Ministry of Water, Irrigation and Energy 

(MoWIE) and Manning’s (n) value from hec-res manual. 

3.3.1 Geometric Data  

Geometric data is the geometrical information of a specific river reach. The geometrical 

data of river was prepared using a tool called HEC-Geo RAS. The river centerline, flow 

path, left and right banks, and cross section cut lines are essential information of the river. 

Finally, these geometric data were used as input for HEC RAS. 

3.3.2 Hydrological Data 

The hydrological data is required as input for HEC RAS model to steady river flow 

analysis of this research. For this study, daily hydrological data of (1987-2008) and 

(1990-2008) of Dijo  and furfuro river gaging station  was collected respectively with 

some missing data of stream flow from the hydrology department of Ministry of Water, 

Irrigation, and Energy (MoWIE) of Ethiopia. The calibration and validation of observed 

and simulated data of the rivers are very essential for checking the quality of the stream 

flow data.  

Table 2 Hydrological stations in Dijo watershed 

s/no Station Name  data 

type 

data 

availability  

no 

years 

1  Jidu Children Village daily 1987-2008 22 

2 Furfuro  Wulbareg daily 1990-2007 18 

3.4 METHODOLOGY 

This section provides a detailed description of the methodology, which is applied to 

obtain the floodplain modeling and mapping results. General methods for doing 

flood plain mapping for a water bodies like river and stream have Four major stages 

fill missing data’s, check consistency, hydrological data preparation (flood 

frequency analysis), pre-processing, processing/model execution and post 

processing. Microsoft excel 2016 tool, Easy fit tool, HEC-RAS and HEC-GeoRAS 

GIS extension are tools used to prepare the flood inundation map of the 4km 
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downstream (Alage AVTET collage) reach of Dijo River. The Preprocessing stage 

consists input data preparation by using HEC-GeoRAS GIS extension tool, which 

helps in creation of the data needs for the HEC-RAS model and the transfer of data 

between ArcGIS and HEC-RAS processing stage did completely within HEC-RAS 

using the river geometry prepared in the Preprocessing stage.  

 

Figure 3 Methodology 

3.4.1 Missing data  

Full and latest hydrological time series data are very essential for water resources 

planning, management and reliable hydrological& hydraulic modeling. The hydrological 

data gaps serious in any data shortage areas of the world particularly in developing 

countries. The disorder model calibration results, unreliable timing of peak flows, and 

biased statistics are the result of missing data (Dembélé et al., 2018). The cause of 
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missing data is the failure of monitoring equipment, extreme weather conditions, limited 

accessibility to measurement sites, negligence/ absence of observers, human-induced 

errors, budget constraints, and political conflicts (Dembélé et al., 2018). 

The missing data were filled by linear regression using Microsoft excel 2016 tool 

After the consistency of hydrological data was checked.  

3.4.2 Hydraulic Analysis 

HEC-RAS and its extension HEC-GeoRAS, which is used to prepare the flood inundation 

map of the downstream reach of Dijo River. HEC-RAS was used to compute water 

surface elevations from a specified flow rate (steady flow simulation). It requires two 

basic inputs for flow analyses: geometric data and flow data. The geometric data file 

includes all the information related to cross-sectional station and elevation data, reach 

lengths, bank stations, stream junctions, and the geometry of hydraulic structures. The 

flow data requires defining boundary conditions, peak discharges for steady type 

simulation. The pre- processing of the geometric data is used to extract the physical 

characteristics of the study area /river reach of Dijo River and the post-processing of the 

outputs (to visualize the flooding impact) that analysis by the HEC-GeoRAS. This GIS 

extension tool allows the preparation of geometric data import into HEC-RAS and 

processes simulation results exported from HEC-RAS in a geospatial environment. To 

create the geometric file, the total station instrument collected surveying river cross 

section data converted to a TIN (Triangulated Irregular Network). 
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 Figure 4 procedure of TIN data 

 

Figure 5 Dijo River Alage reach TIN 
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Figure 6  Downstream reach DEM of dijo River  

3.4.3 Pre-processing data 

Preprocessing is the first stage in preparing floodplain maps.  

Procedures of Geometric data preparation/ pre processing 
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Open GIS 10.3 

Add surveying data 

Convert the data in to TIN data 

Click on RAS Geometry  

Then click on create RAS layers 

 Stream center line 

 Left and right bank lines 

 Flow path centerlines 

 XS cut lines 

 Levee alignment 

Click on each RAS layers and start editing 

Select and click on line and draw  

 1
st
 stream centerline 

 2
nd

 bank lines 

 3
rd

 flow path lines 

 4
th

 XS cut lines it will draw from left to right  

Assign River code, reach code and flow path left and right line type 

Click on RAS Geometry then click  

 stream centerline attributes 

Xs cut lines Attributes 

Finally go back to RAS Geometry and export RAS data in to HEC-RAS by sdf. File 

format. 
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 Figure 7 dijo River D/s reach geometric data 
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Figure 8 Tin with geometric data 

3.4.4 Processing/Model Execution 

 Now open HEC-RAS then new project would save in the specific name in the particular 

folder. GIS data will import into HEC-RAS by clicking on Edit -> Geometric Data. In the 

geometric data editor, select File -> Import Geometry Data -> GIS Format. Import. sdf 

file which was created in GIS will select and ok. Finally click to import the Data to HEC-

RAS. 
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Click on Edit -> steady flow data in HEC-RAS key window. Downstream Boundary 

conditions are also defined by clicking Reach Boundary Conditions. Downstream is 

select, critical depth. The file would be saved. Finally, the virtual data will be transfer to 

ArcGIS, by clicking on File -> Export GIS Data in the main HEC-RAS window. Clicking 

on Export Data button, a sdf file will create. The project will be saved and execute. 

 

Figure 9 selected x- sections along the reach 

3.4.5 Post processing of data 

In ArcGIS, clicking on Import RAS SDF file button, the .sdf file can be convert to xml 

file. The process is complete when a dialogue box appears stating the conversion is done. 

The layer setup for floodplain mapping is performing by selecting RAS Mapping -> 

Layer Setup. In the layer setup, New Analysis option will select and name as Steady flow. 

Single terrain type is select and browses to tin. Working folder. OK will click. In the next 

step, click on RAS Mapping -> Import RAS Data. During Importing of the data, a series 
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of execution messages will be seen. After completing of this a bounding polygon is, 

improve which defines the analysis extent for inundation mapping, obtained by 

connecting the ends of XS cut lines. After defining the analysis extent, the inundation 

extent can be mapping. Here the inundation extent is will map with maximum water 

surface. Click on RAS Mapping -> Inundation Mapping -> Water Surface Generation. 

Select max WS and click ok. Then Click on RAS Mapping-> Inundation Mapping -> 

Floodplain Delineation using Raters. Select max WS (profile with highest flow), and click 

ok. 

To estimate water surface profiles and extent of inundation under different flood 

intensities, peak discharges for different return periods are required. Flood frequency 

analysis was carried out to obtain flood peaks for different return periods. 

 

Figure 10 probability distribution curve 

3.4.6 Fitting a Flood Probability Distribution 

 Different probability distribution methods are considered to test the goodness of fit. 

Normal, Log- Pearson type three, Gen.   Extreme   value   and   Gumbel   distribution 

methods   were   estimated. Then   sample   data has   were simulated and fit with 

statistical distributions by using easy fit software. Goodness of fit tests such as 

Kolmogorov- Smirnov, Anderson-Darling and Chi-square were conducted at significance 

level (α=0.09829) for choosing the best probability distribution. The distribution with 

minimum statistics value was the value that is best fit with the data. 
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Using Kolmogrov-Smirnov test (D) and Anderson Darling test (A
2
) test was observed that 

the General Extreme value distribution provides good fit to the yearly discharge data at 

the exit. Using Chi-squared test (X
2
), the result displayed that Log-Pearson 3 provides 

good fit at the exit. Comparing the three goodness of fit tests, the Kolmogrov-Smirnov 

test (D) has been found to provide a good fit for selected discharge at the exit. 

Table 3 Goodness fit test 

No Distribution Kolmogorov 

Smirnov 

Anderson Darling Chi-Squared 

Statistic Rank Statistic Rank Statistic Rank 

1 Gen. Extreme Value 0.09829 1 0.28006 1 0.47615 4 

2 Log-Pearson 3 0.10096 2 0.29188 3 0.11678 2 

3 Johnson SB 0.10279 3 0.28579 2 0.5357 6 

 

 

Figure 11 probability density function  
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4 RESULTS AND DISCUSSION 

4.1 FLOOD FREQUENCY ANALYSIS  

  Prior to flood frequency analysis, gaging stream flow data is filled its missing data using 

linear regression by using the data of furfuro stream flow gaging station. The result of the 

regression shows that R
2
 of the two-stream flow gaging station data are 0.91, since they 

have good relation. Extrapolation of yearly data are also important for extension of 

insufficient year data to sufficient year data. Therefore, in this research I used 

extrapolation to determine peak discharge of 2009-2020 years and get the goodly 

approached result from previous years recorded data. After completion of filling missing 

data and extrapolation, flood frequency analysis performed using the Gumbel’s (Gen. 

Extreme Value) distribution by using Microsoft excel 2016. Since the results of 2, 10, 25, 

50 and 100 return period years show the table 2 below. 

                

                                   

Figure 12 Flow duration curve 
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Table 4 Return periods & Peak flows 

T Xt(m
3
/s) 

2 101.2 

10 164.60 

25 175.80 

50 207.58 

100 227.83 

 

 

 Figure 13 Peak discharge versus return periods 

These Gumbel’s distribution function calculated values are used for HEC-RAS input. 

To check the annual peak discharge of return period data are normal status or abnormal 

status seat the threshold value is very essential. I use residual mean plot method by using 

Microsoft excel and easy fit 5.5 tool. Since the result of threshold, value is 62m
3
/s. The 

result of all annual return period data is greater than threshold value so it is possible to 

conclude that there is flood at Dijo downstream reach.   
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Figure 14 Threshold Graph 

4.2 FLOODPLAIN MODELING  

 The Quality of geographic data of the river and the flood plain areas are very crucial to 

meet the objective of the research. Since quality is depend on its source of the data. 

Different researchers fetches different (DEM/TIN) from USGS, Alaska, google earth and 

GPS instrument (Abera, 2011; Feyissa & Tufa, 2019; Franco & Tesfaye, 2020; Gebre SL, 

2015; Hajibayov et al., 2017; Khattak et al., 2016) with different resolution. However, the 

quality of DEM/TIN data’s are depend on their resolution. The cross section of 

downstream reach of dijo river is not seen by 90m*90m, 30m*30m, 20m*20m, 

12.5m*12.5m DEM, google earth and GPS data. Hence, to answer these issues I use total 

station instrument take surveying data of the reach and obtain 8m*8m DEM/TIN for this 

research. This data represents the cross section of Dijo River.  

To identify flood venerable cross sections and to map flood plain of Dijo River 

downstream reach 27 x- section cut lines have been drawn on river geometric data. 

Among these cross-sections 3566.674, 3511.198, 3312.854, 3197.66, 3111.642, 

2875.572, 2675.119, 2625.129, 2587.403, 2519.366, 2447.911, 678.182, 1474.751, 

1340.8582, 1078.580, 615.4391m, 511.2469, 2267.12, 2104.231, 2042.637, 1865.22 

(77.8%) of the total x-sections are severely flood venerable x-section stations from 10, 25, 

50 and 100 return period peak flood discharges to both side the river. These listed stations 
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are around bee farm area, old administration residential area, church, nok, 01 residential 

areas, chefe Agricultural and grassland areas.  

 

Figure 15 Dijo River x- section 2675.119m 

 

Figure 16  Dijo river x- section 1340.858m 
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Figure 17 Dijo River x- section of 3566.674m 

 

Figure 18 100 years return period directional plot.  
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 Figure 19 Dijo River x- section of 1865.22m 

 

 

Figure 20 Dijo River x- section of 3511.198m 
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Figure 21 flood venerable bee farm area cross section  
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Figure 22 old administration area cross section 

In 2-years, return period peak flood discharge only 40.74% of river x-sections are flash 

flood to the collage and to naqa kebele. This river flood not approach to the existing 

earthen levee. 59.3% of the x-sections are not disperse the flood to the collage and naqa 

kebele. See fig. (19, 20). Generally, if the peak discharges increase the venerable x-

section of the river is also increase. 
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Figure 23 Dijo River x- section 807.846m 

 

Figure 24 Dijo river x- section 3511.198m 
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Figure 25 2-years return period X-Y-Z perspective Water surface profile 

4.3 Flood Inundation Mapping 

Flood Inundation Mapping is significant tool for designers, planners, and responsible 

body’s emergency action plans and ecological studies. Flood venerable x-section and the 

amount of flooded area is very important to planning, set mitigation measure and 

management the collage and naqa kebele. The inundation area of 2, 10, 25, 50 and 100-

year floods are 5702, 8154.71, 8499.96, 9271.9 and 9851.84m
2
. Most of the areas are at 

the Alage ATVEC. This flood reaches Bee farm area, 01 teacher’s residential areas, old 

administration residential area, church, nok, 01 residential areas, chefe Agricultural and 

grassland areas are more inundating area. It can be occurred due to a narrow of the river 

channel, meandering of the river and exceed of peak flood discharges. I prepared flood 

inundation map of Dijo River downstream (Alage ATVEC) reach by using 2, 10, 25, 50 

and 100 return period peak flows. 
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Figure 26  2 years return period flood map 

This 2-year return period flood plain map has covers 5702m
 2

, which is the result of 

101.19 m
3
/s peak discharge of the river. The map covers small area near the riverbanks. 

The exiting earthen levee is free from flooding. Flood is spread near to riverbanks. I.e., in 

this flood plain map 59.3% of the x-sections, not flash the flood neither to the collage nor 

to the Naqa kebele. Hence, the flood-affected area is also small.   
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Figure 20 flood Plain map of 100 years return period 

This 100-year return period flood plain map shows that out of the right and left 

riverbanks. Bee farm area, arefe ayne grazing and agricultural area,ortodox church, nock, 

chefe agricultural area, ogaden grass area, the main entrance road from bera town to zeray 

01 administration area road and bera town to old administration and mosque road areas 
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are affected by flood. In general, the above listed areas are the basic valuable area of the 

collage and continuously flood-affected area from10, 25, 50, and 100 -years return period 

but flood depth depend on the peak discharge of return periods. The inundation area of 2, 

10, 25, 50 and 100-year floods are 5702, 8154.71, 8499.96, 9271.9 and 9851.84m2 

respectively.  

Table 5 Area of inundated and water level 

      Depth 

Return 

periods (year) 

Peak 

Discharges(m
3
/s) 

Inundated 

area (m
2 

) 
Minimum  Mean Maximum  

2 101.217 5702 0 0.8 2.511 

10 164.6 8154.71 0 0.802 2.62 

25 175.8 8499.96 0 0.81 2.66 

50 207.58 9271.9 0 0.839 2.717 

100 227.83 9851.84 0 0.859 2.857 

Previously made earthen dyke/ levee from alage-Bera Bridge to kuba village to prevent 

the collage from dijo river flooding, the villagers also used as an access road. The 

minimum and the maximum height of the dyke are 0.1 and 0.45m respectively. This 

indicates the height of the dyke is less than the depth of a flood.  
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Figure 27  locally made earthen dyke 
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5 CONCLUSION AND RECOMMENDATION 

5.1 CONCLUSION 

The aim of the research was preparation of floodplains map of the downstream reach of 

Dijo River. The prepared data were incorporated with HEC-RAS, GIS and its extension 

tool called HEC-GEORAS software programs to identify the planed floodplains. This 

study uses the steady state analysis and GIS. Topographic analysis using Arc GIS and 

surveying data has a greatly effectiveness to represent terrain nature exactly. The total 

station surveying data have advanced and the most accurate for the floodplain map. 

In this study, HEC-RAS, Arc GIS 10.3, HEC-Geo RAS and excel 2016, extension models 

were used for flood modelling of dijo River. HEC Geo RAS used to prepare and process 

geometric input from surveying data and delineate floodplain map. The geometric data 

prepared has 27x- sections. In addition, the flood frequency analysis of dijo River is 

conducted to estimate peak flood magnitude of the river. Flood mapping was done 

properly and inundation area and flood depth were interrelated. From the result of this 

study, it is possible to conclude that there are several x-sections, which are continuously 

venerable to flooding along Dijo riverbank against to the return periods. The result 

indicates that not only Alage ATVEC /right side/ the left side/Naqa kebele/ of the river is 

also exposed to flooding at all return period peak discharges but  the extent flood 

occupied area are vary .  Old Administration residential area, nock area, church area, bee 

farm area, chefe cultivated and grassland areas in the college and residential and 

agricultural area of Neqa kebele are flood venerable areas. The 2, 10, 25, 50 and 100 

years return period  peak discharges are 101.22, 164.6, 175.8, 207.58, 227.83m3/s and 

flood occupied area  are 5702, 8154.71, 8499.96, 9271.9 and 9851.84m2 respectively. 
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5.2 RECOMMENDATION 

 Flood inundation map is primary precondition to protect the downstream reach of 

Dijo River. B/c it indicates the affected areas of the collage. 

 Concerned body increase the height and width of exiting levee at the upstream of 

alage-Bera Bridge and construction of new levee on downstream of alage- Bera 

Bridge and naqa kebele and de-silting at vulnerable x-sections to prevent loss life 

and property damage.  

 The responsible bodies also actively and cooperatively work together with dijo river 

upper watershed areas responsible bodies for watershed management works.  

 The recommended flood remedial measures prioritize from any other works.  

 The coming new researcher’s conduct the research on selection of appropriate 

remedial measures with its detail designs depending on land use land cover and 

return period peak discharges.  

 Use other hydraulic models in order to know flooding pattern more effectively. 

 The coming researchers focus on flood risk analysis based identifies flood risk area 

based on detail survey of the collage area and set the mitigation area of venerable 

areas.
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7  APPENDICES 

Appendix- I Manning’s n coefficient 
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Appendix- II Table  flood frequency analysis 

Years Yearly 

peak 

flow(m
3
/s) 

Descending 

order 

Rank(m) probability of 

occurrence(m/n+1) 

Return 

period(TP) 

1987 93.003 177.874 1 0.0286 35 

1988 81.052 172.4003 2 0.0571 17.5 

1989 52.11 166.9266 3 0.0857 11.67 

1990 74.763 161.4529 4 0.1143 8.75 

1991 101.418 155.9792 5 0.1429 7 

1992 90.25 150.5055 6 0.1714 5.833 

1993 96.25 145.0318 7 0.2000 5 

1994 71.35 139.5581 8 0.2286 4.375 

1995 76.623 134.0844 9 0.2571 3.889 

1996 97.868 128.6107 10 0.2857 3.5 

1997 105.031 123.137 11 0.3143 3.182 

1998 101.418 117.6633 12 0.3429 2.917 

1999 96.466 112.1896 13 0.3714 2.692 

2000 71.712 105.031 14 0.4000 2.5 

2001 86.264 105.031 15 0.4286 2.333 

2002 86.14 105 16 0.4571 2.188 

2003 77.876 101.418 17 0.4857 2.059 
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Years Yearly 

peak 

flow(m
3
/s) 

Descending 

order 

Rank(m) probability of 

occurrence(m/n+1) 

Return 

period(TP) 

2004 85.603 101.418 18 0.5143 1.944 

2005 101.418 101.418 19 0.5429 1.842 

2006 105.031 97.868 20 0.5714 1.75 

2007 105 96.466 21 0.6000 1.667 

2008 112.1896 96.25 22 0.6286 1.591 

2009 117.6633 93.003 23 0.6571 1.522 

2010 123.137 90.25 24 0.6857 1.458 

2011 128.6107 86.264 25 0.7143 1.4 

2012 134.0844 86.14 26 0.7429 1.346 

2013 139.5581 85.603 27 0.7714 1.296 

2014 145.0318 81.052 28 0.8000 1.25 

2015 150.5055 77.876 29 0.8286 1.207 

2016 155.9792 76.623 30 0.8571 1.167 

2017 161.4529 74.763 31 0.8857 1.129 

2018 166.9266 71.71 32 0.9143 1.094 

2019 172.4003 71.35 33 0.9429 1.061 

2020 177.874 52.11 34 0.9714 1.029 

Mean   110.06057       
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Years Yearly 

peak 

flow(m
3
/s) 

Descending 

order 

Rank(m) probability of 

occurrence(m/n+1) 

Return 

period(TP) 

sd   32.64       

YN   0.5396       

SN   1.1255       

RT YT k Xt(m
3
/s) 

2 0.37 101.217 

10 2.25 1.5200 164.6 

25 3.20 2.3624 175.8 

50 3.90 2.9874 207.58 

100 4.60 3.6078 227.83 

         NB:    Yn =Reduced mean,   N = sample size 
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Appendix- III Threshold values 

Threshold Mean 

16 59.0769 

17 59.1004 

18 59.1511 

29 49.2163 

35 44.1193 

39 40.9406 

43 38.5425 

50 32.2994 

52 30.9468 

54 31.6879 

57 29.3917 

59 31.1091 

60 30.9269 

62 29.7591 

65 27.5598 

68 25.3245 

69 25.048 
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Threshold Mean 

71 23.7975 

74 23.106 

76 23.5886 

77 24.4258 

81 22.4737 

82 22.4928 

84 21.5169 

85 25.5112 

86 26.0679 

93 20.7882 

96 19.2729 

97 21.4073 

101 19.2745 

105 22.3457 

116 18.784 

126 18.0555 

132 18.0177 

137 21.998 

180 0.66 

Appendix- IV Total station surveying data 
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PtID East North Elevation 

R1 438132 842710 1579.96 

L1 438113 842738 1579.84 

C45 438120 842717 1574.25 

R2 438170 842645 1579.05 

LS82 438069 842793 1579.76 

1.1 438034 842728 1579.96 

RS70 438028 842699 1579.77 

LS77 438042 842567 1578.78 

LS81 438040 842773 1579.68 

1.5 438010 842578 1579.14 

RS68 437964 842698 1580 

1.7 437963 842732 1580.24 

LS80 437999 842779 1580.27 

RS67 437920 842709 1580.35 

1.1 437907 842696 1580.06 

RS66 437925 842748 1580.5 

C42 437933 842719 1574.99 

RFP47 437877 842732 1580.6 

1.16 437860 842700 1580.35 

LS79 437971 842804 1580.4 

LFP37 437994 842830 1580.03 

RS65 437885 842780 1580.26 

RFP46 437850 842745 1580.53 

LS78 437934 842831 1580.51 

LFP36 437938 842862 1580.19 

C41 437902 842791 1574.87 

1.27 437902 842747 1575.32 

RS64 437868 842789 1580.38 

1.29 437844 842724 1580.58 

1.3 437884 842854 1580.46 

RS63 437842 842791 1580.52 

LFP35 437865 842874 1580.3 

RS62 437829 842789 1580.5 

RS61 437819 842777 1580.58 

LS76 437839 842850 1580.01 

RS60 437811 842757 1580.7 

LS75 437823 842840 1580.6 

LS74 437802 842823 1580.71 

C40 437831 842810 1575.13 

LS73 437781 842805 1580.78 

LS72 437775 842783 1580.49 
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LS71 437776 842752 1580.51 

RS59 437809 842743 1580.73 

RFP45 437830 842736 1580.54 

RFP44 437813 842705 1580.63 

2.21 437825 842702 1580.54 

LFP34 437722 842818 1580.22 

RFP43 437809 842694 1580.58 

2.24 437820 842669 1581.12 

LFP33 437716 842790 1579.99 

RFP42 437800 842684 1580.64 

2.27 437801 842664 1579.94 

LFP32 437715 842769 1579.87 

RFP41 437785 842673 1580.66 

2.3 437783 842656 1580.1 

RFP40 437766 842663 1580.78 

2.32 437764 842649 1580.05 

C39 437792 842765 1574.84 

C38 437787 842745 1575.01 

LS70 437777 842747 1580.22 

2.3 437760 842746 1580.52 

RFP39 437749 842651 1580.86 

2.32 437746 842637 1580.01 

RFP38 437733 842643 1581.06 

2.34 437732 842628 1579.73 

LS69 437774 842731 1580.54 

RS58 437758 842692 1580.74 

RFP37 437677 842630 1581.14 

RS57 437704 842637 1581 

LS68 437724 842700 1580.62 

LS67 437704 842669 1581.03 

LFP31 437695 842707 1580.57 

RS56 437666 842633 1581.12 

LS66 437664 842670 1581.1 

RFP36 437664 842617 1580.31 

LFP30 437659 842701 1580.78 

RFP34 437615 842651 1581.09 

RFP35 437600 842620 1580.21 

RS55 437594 842699 1581.05 

RFP33 437588 842692 1580.69 

C37 437687 842656 1575.24 

LS65 437658 842670 1581.11 

LS64 437626 842693 1581.22 
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LS63 437611 842721 1581.08 

LS62 437602 842737 1581.21 

LS61 437591 842752 1581.56 

LFP29 437599 842773 1580.89 

LS60 437576 842775 1581.37 

LFP28 437571 842811 1581.19 

LFP27 437546 842826 1581.33 

RS54 437562 842740 1581.37 

RFP33 437550 842732 1580.59 

C36 437552 842778 1575.29 

RS 53 437537 842763 1581.26 

RFP31 437523 842757 1581.67 

RS52 437517 842778 1581.2 

RFP30 437508 842759 1580.98 

C35 437487 842796 1575.3 

RS51 437483 842781 1581.43 

RFP29 437482 842748 1580.66 

RFP28 437444 842740 1580.95 

Rs50 437438 842764 1581.52 

C34 437428 842787 1575.39 

Rs49 437410 842762 1581.71 

RFP27 437415 842736 1581.29 

RS48 437384 842760 1581.63 

RFP26 437390 842741 1580.86 

Rs47 437355 842755 1581.84 

RFP25 437359 842735 1581.6 

LS59 437558 842785 1581.7 

LS58 437527 842802 1581.34 

LS57 437507 842809 1581.39 

LS56 437473 842813 1581.52 

LS55 437450 842805 1581.53 

LS54 437382 842789 1581.46 

LS53 437406 842795 1581.59 

LS52 437369 842785 1581.43 

LS50 437338 842782 1582 

LFP26 437424 842858 1581.32 

LFP25 437372 842835 1581.11 

LS51 437345 842773 1575.63 

RS 46 437327 842753 1581.6 

RFP24 437339 842727 1581.3 

DBR1 437319 842750 1582.42 

DBR2 437318 842754 1580.01 
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DBR3 437313 842773 1580.1 

DBR4 437314 842791 1583.46 

UDR1 437310 842748 1583.1 

C33 437299 842766 1575.94 

UBR1 437304 842772 1579.09 

UBR2 437308 842756 1577.69 

UBR3 437299 842782 1583.15 

C32 437252 842753 1575.6 

Rs43 437262 842747 1581.27 

2.151 437270 842725 1581.75 

Rs42 437252 842728 1582.13 

2.153 437290 842692 1581.73 

Rs41 437248 842700 1582.53 

RS40 437251 842685 1582.26 

2.156 437290 842666 1582.01 

LS46 437277 842781 1582.09 

LS45 437237 842753 1581.66 

LS44 437216 842732 1582.05 

LS43 437212 842723 1581.62 

LS42 437211 842693 1582.38 

LS41 437217 842668 1582.02 

LS40 437225 842655 1582.15 

LFP24 437262 842801 1581.57 

LFP23 437216 842784 1581.79 

C31 437230 842718 1576.08 

C30 437250 842655 1576.15 

LFP22 437185 842671 1581.89 

LFP21 437182 842655 1581.72 

LFP20 437220 842612 1582.39 

Rs39 437269 842664 1582.57 

2.204 437303 842675 1582.16 

LFP19 437212 842585 1582.55 

Rs38 437302 842622 1582.53 

LS39 437251 842635 1582.36 

Rs37 437305 842567 1582.54 

LS38 437263 842621 1582.25 

RFP23 437341 842567 1583.43 

C29 437294 842609 1575.87 

C28 437285 842562 1576.62 

Rs36 437285 842538 1582.65 

RFP22 437307 842515 1583.41 

Rs35 437264 842523 1582.5 
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RFP21 437284 842503 1583.35 

C27 437227 842546 1575.77 

Rs34 437238 842523 1582.12 

RFP20 437244 842487 1583.38 

Rs 33 437215 842522 1582.49 

RFP19 437220 842472 1583.55 

C26 437158 842516 1576.63 

Rs32 437178 842514 1581.69 

1.271 437149 842522 1582.69 

LS29 437173 842542 1582.62 

LS30 437189 842552 1582.86 

LS31 437204 842560 1582.85 

1.275 437242 842561 1582.53 

LS32 437250 842555 1582.44 

LS33 437257 842557 1582.47 

LS34 437264 842562 1582.32 

LS35 437273 842580 1581.96 

LS36 437275 842604 1581.85 

LS37 437269 842617 1581.97 

1.282 437229 842601 1582.03 

LFP18 437159 842557 1582.61 

LFP17 437131 842535 1582.66 

1.285 437105 842514 1582.56 

Rs31 437156 842487 1582.56 

Rs30 437137 842464 1582.79 

Rs29 437119 842448 1582.58 

Rs28 437078 842407 1582.86 

RFP18 437171 842455 1584.03 

RFP17 437139 842396 1584.28 

C25 437136 842485 1576.75 

C24 437096 842447 1576.73 

RFP16 437105 842353 1582.26 

C23 437056 842405 1576.71 

LS28 437128 842497 1582.7 

LFP16 437100 842526 1582.39 

LFP15 437069 842502 1582.31 

LS27 437075 842446 1582.89 

LS26 437028 842382 1582.99 

LFP14 436988 842426 1582.42 

LFP13 436954 842388 1582.64 

LS21 436881 842319 1583.27 

RFP15 437125 842278 1584.09 
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RFP14 437079 842209 1583.62 

LS25 437016 842363 1582.97 

C22 437030 842358 1576.76 

C21 437011 842309 1576.72 

RFP13 437011 842140 1583.65 

LS24 437003 842336 1583 

Rs24 436988 842276 1582.53 

Rs25 436994 842284 1583.06 

Rs26 437024 842307 1583.11 

Rs27 437035 842322 1583.13 

RFP12 436975 842101 1583.97 

Rs50 436933 842290 1583.27 

LS23 436943 842321 1583.33 

RFP11 436931 842052 1584.04 

Rs22 436894 842265 1583.37 

LS22 436912 842319 1583.42 

L61 436874 842311 1583.32 

LS20 436844 842288 1583.31 

LS19 436825 842259 1583.36 

LS18 436810 842244 1583.43 

LFP9 436803 842283 1583.02 

LFP10 436822 842313 1583 

LFP11 436846 842335 1583.02 

LFP12 436896 842360 1583.03 

C21 436942 842311 1577.23 

C20 436897 842296 1577.57 

RS21 436889 842260 1583.37 

CX19 436848 842255 1577.5 

Rs20 436827 842216 1583.35 

Rs19 436773 842182 1583.34 

C18 436789 842209 1577.73 

R80 436705 842110 1583.04 

C17 436752 842179 1578.03 

LS15 436739 842174 1583.44 

LS16 436767 842210 1583.46 

LS17 436797 842238 1583.37 

LFP8 436765 842277 1582.8 

LFP7 436706 842234 1582.72 

Rs18 436775 842183 1583.42 

Rs17 436759 842152 1583.48 

LS14 436728 842166 1583.45 

RFP10 436851 841969 1584.14 
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L100 436705 842111 1583.51 

Rs16 436706 842110 1583.52 

LS13 436712 842145 1583.44 

Rs15 436655 842081 1583.66 

LS12 436682 842131 1583.52 

LS11 436636 842110 1583.55 

Rs14 436572 842040 1583.81 

LS10 436574 842081 1583.86 

C16 436707 842131 1577.47 

C15 436674 842113 1577.76 

C14 436641 842089 1577.67 

C13 436582 842059 1577.94 

C11 436528 842019 1578.11 

LFP5 436594 842111 1583.46 

LFP6 436627 842156 1583.06 

RFP9 436801 841914 1584.32 

RFP7 436766 841841 1584.14 

RFP6 436756 841814 1583.97 

C12 436548 842051 1577.94 

LS9 436509 842005 1583.71 

Rs13 436565 842033 1583.79 

LS8 436537 841964 1584.06 

LFP4 436482 842015 1583.51 

Rs12 436558 841989 1583.8 

LS7 436569 841933 1584.08 

LFP3 436504 841955 1583.42 

Rs11 436596 841944 1583.78 

C10 436575 841942 1577.91 

C9 436606 841925 1578.02 

LS6 436657 841890 1584.18 

Rs10 436623 841933 1583.37 

C8 436656 841899 1578.34 

LS5 436640 841853 1583.86 

C7 436695 841865 1578.22 

LFP2 436540 841847 1583.4 

LS4 436666 841794 1584.44 

RFP8 436791 841900 1584.18 

RFP5 436753 841802 1584 

RFP4 436747 841755 1584.44 

C5 436635 841679 1578.99 

C6 436669 841759 1579.03 

R9 436713 841844 1584.42 
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Rs8 436707 841829 1584.08 

R6 436667 841702 1584.28 

Rs7 436680 841744 1584.29 

FRP3 436739 841714 1584.16 

FRP2 436749 841647 1584.57 

FRP1 436764 841593 1585.03 

Rs5 436654 841625 1584.43 

LS3 436577 841670 1584.08 

Rs4 436641 841612 1584.48 

LS2 436601 841580 1584.68 

C1 436478 841330 1579.18 

Rs3 436623 841564 1584.58 

LS1 436570 841524 1584.81 

C2 436500 841368 1578.87 

C3 436528 841415 1578.79 

C4 436573 841489 1578.81 

LFP1 436502 841510 1584.15 

Rs2 436591 841490 1584.73 

Rs1 436558 841439 1584.87 

C43 438085 842713 1575.2 

C44 438117 842721 1575.31 

RS69 438024 842700 1579.82 

RSCROS71 438094 842695 1579.8 

RS73 438131 842706 1580.29 

RS72 X 438129 842697 1579.08 

RS75X 438194 842789 1580.14 

RS76 438237 842882 1579.56 

L600 438124 842738 1579.78 

FRP50 438307 842832 1579.44 

LS85 438176 842836 1579.67 

LS83 438125 842794 1579.39 

LS86 438200 842880 1579.59 

LS84 438140 842833 1579.35 

LS88 438217 842926 1579.44 

FRP49 438241 842706 1578.58 

LS87 438216 842925 1579.39 

RS79 438250 842957 1579.18 

C46 438143 842735 1574.13 

C47 438164 842768 1574.12 

C48 438186 842819 1574.17 

C49 438208 842865 1574.21 

C50 438223 842901 1574.16 
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C51 438228 842933 1574.06 

LS89 438230 842977 1579.28 

C52 438240 842967 1573.92 

LS90 438248 843005 1579.26 

RS77 438245 842940 1579.35 

LFP38 438163 843024 1578.59 

FRP51 438359 842860 1578.41 

FRP52 438431 842896 1577.97 

LFP39 438189 843108 1578.3 

L665 438230 843108 1578.5 

FRP53 438477 842951 1577.41 

FRP54 438470 842981 1577.54 

L718 438285 843113 1578.32 

RS78 438250 842956 1579.32 

RS80 438264 842986 1578.93 

RS81 438287 843010 1579.2 

RS82 438303 843021 1579.26 

C53 438296 843037 1573.73 

LS91 438288 843040 1579.32 

RS83 438332 843050 1579.14 

C54 438322 843060 1574.01 

LS92 438315 843067 1579.19 

RS84 438376 843089 1578.97 

L909 438448 843218 1579.08 

C55 438439 843196 1573.94 

RS85 438432 843169 1579.11 

C56 438464 843217 1573.67 

LS94 438421 843332 1577.35 

LS93 438376 843241 1578.08 
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 Appendix- V Reduced mean (Yn) Table 

N 0 1 2 3 4 5 6 7 8 9 

10 0.4952 0.4996 0.5035 0.507 0.51 0.5128 0.5157 0.5181 0.5202 0.522 

20 0.5236 0.5252 0.5268 0.5283 0.5296 0.5309 0.532 0.5332 0.5343 0.5353 

30 0.5362 0.5371 0.538 0.5388 0.5396 0.5402 0.541 0.5418 0.5424 0.543 

40 0.5436 0.5442 0.5448 0.5453 0.5458 0.5463 0.5468 0.5473 0.5477 0.5481 

50 0.5485 0.5489 0.5493 0.5497 0.5501 0.5504 0.5508 0.5511 0.5515 0.5518 

60 0.5521 0.5524 0.5527 0.553 0.5533 0.5535 0.5538 0.554 0.5543 0.5545 

70 0.5548 0.555 0.5552 0.5555 0.5557 0.5559 0.5561 0.5563 0.5565 0.5567 

80 0.5569 0.557 0.5572 0.5574 0.5576 0.5578 0.558 0.5581 0.5583 0.5585 

90 0.5586 0.5587 0.5589 0.5591 0.5592 0.5593 0.5595 0.5596 0.5598 0.5599 

100 0.56                   

yn =Reduced mean in Gumbel's extreme value distribution, N = sample size 
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Appendix- VI Reduced standard deviation (Sn) Table  

N 0 1 2 3 4 5 6 7 8 9 

10 0.9496 0.9676 0.9833 0.9971 1.0095 1.0206 1.0316 1.0411 1.0493 1.0565 

20 1.0628 1.0696 1.0754 1.0811 1.0864 1.0915 1.0961 1.1004 1.1047 1.1086 

30 1.1124 1.1159 1.1193 1.1226 1.1255 1.1285 1.1313 1.1339 1.1363 1.1388 

40 1.1413 1.1436 1.1458 1.148 1.1499 1.1519 1.1538 1.1557 1.1574 1.159 

50 1.1607 1.1623 1.1638 1.1658 1.1667 1.1681 1.1696 1.1708 1.1721 1.1734 

60 1.1747 1.1759 1.177 1.1782 1.1793 1.1803 1.1814 1.1824 1.1834 1.1844 

70 1.1854 1.1863 1.1873 1.1881 1.189 1.1898 1.1906 1.1915 1.1923 1.193 

80 1.1938 1.1945 1.1953 1.1959 1.1967 1.1973 1.198 1.1987 1.1994 1.2001 

90 1.2007 1.2013 1.202 1.2026 1.2032 1.2038 1.2044 1.2049 1.2055 1.206 

100 1.2065                   

Sn = Reduced standard deviation in Gumbel's extreme value distribution, N = sample size 
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Appendix- VII-Years Return Period Hec-Ras Report 
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Appendix- VIII 50-Years Return Period Hec-Ras Report 
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Appendix- IX 100-Years Return Period Hec-Ras Report 
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Appendix- X property of cross section  

 

Appendix- XI property of cross section 
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Appendix- I 25 years WS direction plot 
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  APPENDEX-II 50 years WS direction plot 
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 Appendix-III 10 year’s floodplain map 
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 Appendix-V 25 year’s floodplain map 
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Appendix-VI 50 years floodplain map 


